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Introduccion

Planteamiento del Problema

En la actualidad, la ensefianza d la historia enfrenta varios desafios. Unos de los
principales es la falta de interés de los estudiantes hacia los métodos tradicionales de
aprendizaje, como las clases expositivas o los textos largos. Esto hace que conceptos
importantes, como los eventos historicos del Ecuador no logren captar su atencion ni ser
retenidos con facilidad. Otro problema que se identifica es la falta de herramientas
interactivas que combinen tecnologia y educacion. A pesar de los avances tecnoldgicos,
todavia existen pocos recursos disefiados especificamente para hacer que la ensefianza
sea mas atractiva y adaptada a las nuevas generaciones. Este proyecto busca resolver este
problema mediante un videojuego educativo que permita a los estudiantes interactuar con
los eventos historicos del Ecuador de una manera entretenida, ayudando a mejorar la
experiencia de aprendizaje.

Justificacion

La historia ecuatoriana es una parte fundamental de nuestra identidad como pais, pero
muchas veces no se ensefia de manera que motive a los estudiantes. Este proyecto tiene
como objetivo principal ofrecer una solucién que combine aprendizaje y tecnologia,
adaptandose a los intereses de los jovenes. El videojuego educativo sera una herramienta
que no solo haré el aprendizaje méas dindmico, sino que también fomentara el pensamiento
critico y la curiosidad por la historia. Ademas, al tratarse de un recurso digital, podra ser
utilizado tanto en aulas como en entornos virtuales, ampliando su alcance y utilidad.
Objetivos

Objetivo General

Diseiar y desarrollar un videojuego educativo que permita a los estudiantes aprender

sobre la historia del Ecuador de manera interactiva y entretenida.



Objetivos Especificos

1. Crear tres niveles interactivos que representes eventos historicos clave, con la

Fundacién de Quito, La independencia de Guayaquil y la Batalla de Pichincha.
2. Desarrollar un sistema de juego que incluya cronometro y vidas para
aumentar el nivel de desafio.

3. Disefiar una interfaz intuitiva y atractiva, utilizando un estilo pixel art.

4. Validar el videojuego con estudiantes para medir su impacto en el aprendizaje.
En este proyecto de tesis se propone desarrollar un videojuego educativo que sea
interactivo y que facilite el aprendizaje de la historia ecuatoriana de manera accesible,
atractiva y que sea entretenida para el estudiante.
El videojuego, nombrado como “Explorador del Tiempo”, permite al estudiante viajar a
eventos historicos cruciales, como la Fundacion de Quito (1534), la Independencia de
Guayaquil (1820) y la Batalla de Pichincha (1822), participando en misiones relacionadas
con estos eventos. A través de mecénicas de juego basadas en el tiempo y la exploracion,
el proyecto lo que busca es que los estudiantes refuercen su comprension y retencion de
estos contenidos mediante el videojuego educativo.
Este trabajo se enfoca en estas dos areas principales, em el levantamiento de requisitos y
disefio del sistema, y la implementacion del videojuego en Unity esto servird como base
técnica para el proyecto. El juego integra componentes educativos mediante un sistema
de vidas en forma de relojes de tiempo y un cronometro que agrega un nivel de desafio
para que el jugador pueda arreglar la linea de tiempo a su forma original, incentivando el
aprendizaje a traves de la superacion de retos historicos.
El objetivo del proyecto es incluir en el desarrollo de una interfaz intuitiva y visualmente
atractiva mediante graficos 2D con una vista Top and Down, la implementacién de

mecanicas de juego van a ir acordes al contenido educativo donde el jugador tendra que



hablar con personajes de ese escenario para saber que cambio en la historia ya que el
villano del juego lo altero y tendiendo conocimiento del evento que se alter6 y el jugador
tendra que arreglarlo haciendo que evento ocurra, también detallando cada fase para

garantizar que el videojuego cumpla con sus metas pedagdgicas.



Capitulo |
Levantamiento de Requisitos y Disefio del Sistema

1.1 Introduccion al Levantamiento de Requisitos

El levantamiento de requisitos es fundamental para establecer las funcionalidades
necesarias del sistema para el videojuego “Explorador del Tiempo”, el objetivo principal
del levantamiento es definir que aspectos educativos e interactivos se requieran para que

el sistema lograra su prop6sito que es mejorar el aprendizaje de a historia ecuatoriana.

1.2 Metodologia del Levantamiento de Requisitos

Para la recoleccién de requisitos, se aplicaron técnicas como entrevistas y encuestas a

estudiantes y educadores, lo cual la recopilacion incluyo lo siguiente:

e Entrevistas a profesores de historia para definir los contenidos de los niveles.
e Encuestas a estudiantes para entender sus preferencias de interaccion y juego.
e Andlisis de documentacion sobre videojuegos educativos y pedagogia histérica

para alinear los objetivos de aprendizajes.

1.3 Resultados del Levantamiento de Requisitos

Modelado del Negocio

El presente diagrama de flujo detalla el funcionamiento del videojuego educativo
“Explorador del Tiempo”, disefiado para ensefiar la historia del Ecuador a los estudiantes
mediante la interaccién con personajes historicos y la recuperacion de fragmentos de

documentos importantes.

El flujo del juego comienza con un menu inicial que permite al jugador seleccionar entre

las opciones de jugar, ajustar la configuracion o salir del juego. Tras seleccionar la opcion
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de jugar, el jugador pasa por un tutorial donde aprende las mecéanicas basicas del juego.

Posteriormente, el jugador es transportado a diferentes épocas histéricas del Ecuador para

completar misiones especificas.
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1. Modelado del Negocio

Pasos Detallados

1. Menu Inicial:
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Mostrar pantalla de bienvenida: El juego presenta una pantalla de

bienvenida con las opciones “Jugar”, “Configuracion”, “Salir”.

Opcion: Jugar: Si el jugador selecciona “Jugar”, es dirigido a la pantalla de

tutorial.
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e Opcidn: Configuracion: Si el jugador selecciona “Configuracion”, es

dirigido a una pantalla donde puede ajustar la configuracién del juego

e Opcidn: Salir: Si el jugador selecciona "Salir", el juego termina.

2. Configuracion:

Pantalla completa: El jugador puede activar o desactivar el modo de
pantalla completa.
e Ajustar volumen: El jugador puede ajustar el volumen del juego.
o Cambiar calidad: El jugador puede cambiar la calidad grafica del juego.
o Volver al mena inicial: El jugador puede regresar al menu inicial desde
la pantalla de configuracion.
3. Tutorial:
Hablar con NPC: El jugador interactta con un NPC que explica las mecanicas béasicas
del juego.
Activar reloj: Tras completar el tutorial, se activa un reloj que transporta al jugador al
primer nivel.
4. Primer Nivel: Fundacién de Quito:
Encuentro con NPC principal (Sebastian de Benalcazar): El jugador habla con
Sebastian de Benalcazar para obtener pistas sobre los fragmentos de documentos.
Explorar zona: El jugador explora la zona y activa nombres flotantes en lugares
historicos.
Hablar con otros NPCs: El jugador interactGa con otros NPCs para obtener mas pistas
sobre los fragmentos.
Reunir fragmentos de documentos: El jugador busca y reune los fragmentos de

documentos necesarios.
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Entrega de objeto: Si el jugador encuentra todos los fragmentos, los entrega a Sebastian
de Benalcazar.

Progresar al siguiente nivel: Si el jugador completa el nivel, progresa al siguiente nivel.
Tiempo agotado: Si el tiempo se agota antes de completar el nivel, el jugador es dirigido
a una pantalla de "Tiempo Agotado" y debe comenzar de nuevo.

5. Segundo Nivel: Independencia de Guayaquil:

Encuentro con NPC principal (José Joaquin de Olmedo): El jugador habla con José
Joaquin de Olmedo para obtener pistas sobre los fragmentos de documentos.

Explorar zona: El jugador explora la zona y activa nombres flotantes en lugares
historicos.

Hablar con otros NPCs: El jugador interactda con otros NPCs para obtener mas pistas
sobre los fragmentos.

Reunir fragmentos de documentos: El jugador busca y reune los fragmentos de
documentos necesarios.

Entrega de objeto: Si el jugador encuentra todos los fragmentos, los entrega a José
Joaquin de Olmedo.

Progresar al siguiente nivel: Si el jugador completa el nivel, progresa al siguiente nivel.
Tiempo agotado: Si el tiempo se agota antes de completar el nivel, el jugador es dirigido
a una pantalla de "Tiempo Agotado” y debe comenzar de nuevo.

6. Tercer Nivel: Batalla de Pichincha:

Encuentro con NPC principal (Antonio José de Sucre): El jugador habla con Antonio
José de Sucre para obtener pistas sobre los fragmentos de documentos.

Explorar zona: El jugador explora la zona y activa nombres flotantes en lugares

historicos.
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Hablar con otros NPCs: El jugador interactGa con otros NPCs para obtener mas pistas
sobre los fragmentos.

Reunir fragmentos de documentos: El jugador busca y reune los fragmentos de
documentos necesarios.

Entrega de objeto: Si el jugador encuentra todos los fragmentos, los entrega a Antonio
José de Sucre.

Final del juego: Si el jugador completa el nivel, el juego finaliza y el jugador es enviado
de vuelta al menu inicial.

Tiempo agotado: Si el tiempo se agota antes de completar el nivel, el jugador es dirigido

a una pantalla de "Tiempo Agotado” y debe comenzar de nuevo.

7. Final del Juego:
Regreso al menu inicial: Al finalizar el juego, el jugador es enviado de vuelta a la

pantalla de mend inicial.

Disefio del Diagrama Caso de Uso

El diagrama de casos de uso proporciona una representacion grafica de las interacciones
entre los actores (jugadores, NPCs, sistema) y los casos de uso (funcionalidades del
juego). Este diagrama ayuda a visualizar como los usuarios interactdian con el sistema 'y

que funcionalidades estan disponibles para ellos.

Diagrama de Casos de Uso:

o Actores:

e Jugador

e NPC (Personajes del juego)
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o Sistema

e Casos de Uso:

e Iniciar sesion

« Seleccionar opcidn en el menu inicial

o Ajustar configuracion

o Completar tutorial

e Jugar nivel

e Gestionar tiempo

o Progresar al siguiente nivel

e Reiniciar juego

Jugador

EXPLORADOR
DEL TIEMPO

| Iniciar sesion

| Seleccionar opcion

| en el mend inicial

‘ Ajustar configuracion

I Completar tutorial -

|

Jugar nivel

‘ Gestionar tiempo ‘_

NPCs

2. Disefio del Diagrama Caso de Uso

‘ Reiniciar juego

SISTEMA
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Descripcion de los Casos de Uso

1.

Iniciar sesion: El jugador inicia sesion en el juego.

Seleccionar opcion en el menu inicial: El jugador puede elegir entre jugar,

ajustar configuracion o salir.

Ajustar configuracion: El jugador puede cambiar la configuracién del juego

(pantalla completa, volumen, calidad) y volver al mend inicial.

Completar tutorial: El jugador habla con un NPC para aprender las mecéanicas

del juego y activar el reloj que lo envia al primer nivel.

Jugar nivel: El jugador explora el nivel, habla con NPCs y retne fragmentos de

documentos.

Gestionar tiempo: El juego tiene un temporizador que, si se agota, muestra una

pantalla de tiempo agotado y reinicia el juego.

Progresar al siguiente nivel: Si el jugador retune todos los fragmentos y habla

con el NPC principal, progresa al siguiente nivel.

Reiniciar juego: Si el tiempo se agota, el juego se reinicia y el jugador debe

comenzar de nuevo.

1.4 Disefio del Sistema

El disefio del sistema define la arquitectura y los componentes esenciales que se utilizaran

dentro del videojuego educativo "Explorador del Tiempo". A continuacidn, se detallan

las tecnologias y herramientas que se emplearan tanto en el frontend como en el backend,

asi como la descripcion de la base de datos.
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Tecnologias por Utilizar
Frontend: Unity

o Descripcion: Unity es una plataforma de desarrollo de juegos que permite crear
experiencias interactivas en 2D y 3D. Es ampliamente utilizada debido a su

flexibilidad y capacidad para desarrollar juegos multiplataforma.
o Libreriasy Bibliotecas:

o Unity Ul Toolkit: Para la creacion de interfaces de usuario interactivas y

responsivas.

e Cinemachine: Para la gestion avanzada de camaras y efectos

cinematogréficos.
o TextMesh Pro: Para la renderizacién de texto de alta calidad.

e Unity Analytics: Para el seguimiento y analisis del comportamiento del

jugador.
¢ Uso de la Herramienta:

e Desarrollo de Niveles: Crear y disefiar los diferentes niveles del juego,
incluyendo la Fundacion de Quito, la Independencia de Guayaquil y la

Batalla de Pichincha.

e Interaccion con NPCs: Implementar la logica de interaccion entre el

jugador y los personajes historicos.

o Gestidn de Objetos: Manejar la busqueda y recoleccion de fragmentos de

documentos.
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o Interfaz de Usuario: Disefiar menus, pantallas de configuracion y

elementos de HUD (Head-Up Display).

Backend: PlayFab

o Descripcion: PlayFab es una plataforma de backend como servicio (BaaS) que
proporciona una infraestructura robusta para juegos, incluyendo gestion de datos,

autenticacion de usuarios, y analisis.

¢ Finalidad del Uso:

Conexién con Base de Datos: Almacenar y gestionar datos de jugadores,

progreso del juego, y estadisticas.

o Autenticacion de Usuarios: Implementar sistemas de inicio de sesion y

gestién de cuentas.

e Protocolos de Seguridad: Asegurar la integridad de los datos y proteger
la informacidn sensible de los jugadores mediante cifrado y autenticacion

segura.

e Andlisis y Telemetria: Recopilar y analizar datos sobre el

comportamiento del jugador para mejorar la experiencia de juego.

Almacenamiento de Datos

Base de Datos: Firebase Firestore

o Descripcion: Firebase Firestore es una base de datos NoSQL en tiempo real que
permite almacenar y sincronizar datos entre los clientes y el backend de manera

eficiente.

e Uso en el Juego:

18



o Almacenamiento de Datos del Jugador: Guardar informacién sobre el
progreso del jugador, fragmentos de documentos recolectados, y

estadisticas de juego.

o Sincronizacion en Tiempo Real: Asegurar que los datos del jugador se
actualicen en tiempo real, permitiendo una experiencia de juego fluida y

coherente.

o Escalabilidad: Manejar grandes volumenes de datos y usuarios

simultaneos sin comprometer el rendimiento.

o Seguridad: Implementar reglas de seguridad para controlar el acceso a los

datos y proteger la informacion sensible.

1.4.1 Arquitectura del Sistema

Se seleccion6 una arquitectura cliente-servidor para el videojuego educativo "Explorador
del Tiempo", permitiendo una experiencia de usuario eficiente y escalable. Esta
arquitectura consta de un frontend desarrollado en Unity y un backend que gestiona los

datos y el progreso del jugador.

Funcionamiento del Juego con la Arquitectura Cliente-Servidor

1. Cliente (Frontend):

o Descripcidn: El cliente es la aplicacion de juego desarrollada en Unity que

actua como la interfaz principal para el jugador.
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Interaccion con el Usuario: El jugador interactda con el juego a través de
la interfaz de usuario, que incluye mendus, niveles, personajes y elementos

interactivos.

Conexion al Servidor: Al iniciar el juego, el cliente establece una

conexién con el servidor para autenticar al jugador y sincronizar los datos.

2. Servidor (Backend):

Descripcion: El servidor es responsable de procesar las operaciones del
juego y almacenar la informacion relevante. Utiliza PlayFab para la

gestién de datos y Firebase Firestore como base de datos.

Procesamiento de Operaciones: Una vez establecida la conexion, el
servidor maneja todas las operaciones posteriores, como la autenticacion
de usuarios, el seguimiento del progreso del juego, y la gestion de

estadisticas.

Almacenamiento de Informacién: El servidor almacena informacion
sobre el progreso del jugador, fragmentos de documentos recolectados, y

estadisticas de juego en Firebase Firestore.

Flujo de Datos en la Arquitectura Cliente-Servidor

1. Inicio de Sesion:

El jugador inicia sesion en el juego desde el cliente (Unity).
El cliente envia las credenciales al servidor (PlayFab) para autenticacion.
El servidor verifica las credenciales y responde con la confirmacion de

inicio de sesion.
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2. Sincronizacion de Datos:

e Una vez autenticado, el cliente solicita los datos del jugador (progreso,

estadisticas) al servidor.

o El servidor recupera los datos de Firebase Firestore y los envia al cliente.

o El cliente actualiza la interfaz de usuario con los datos recibidos.

3. Interaccion en el Juego:

o Durante el juego, el jugador interactia con NPCs, recolecta fragmentos de

documentos y completa misiones.

o Elcliente envia las acciones del jugador al servidor para su procesamiento.

o El servidor actualiza los datos del jugador en Firebase Firestore y envia la

confirmacion al cliente.

4. Gestion del Progreso:

e Al completar un nivel, el cliente envia la informacién de progreso al

servidor.

o El servidor actualiza el estado del jugador en Firebase Firestore y envia la

confirmacion al cliente.

« Si el tiempo se agota, el servidor notifica al cliente para mostrar la pantalla

de "Tiempo Agotado™.

5. Final del Juego:

« Al finalizar el juego, el cliente envia una solicitud al servidor para guardar

el progreso final.
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e El servidor almacena los datos finales en Firebase Firestore y envia la

confirmacion al cliente.

« Elcliente redirige al jugador al menu inicial.

Diagrama de Arquitectura del Sistema

El diagrama de arquitectura del sistema para el videojuego educativo "Viajero del

Tiempo" ilustra como se integran y funcionan los componentes tecnoldgicos clave,

incluyendo el frontend, el backend, la base de datos y los archivos JSON. A continuacion,

se describe cada uno de estos componentes y su interaccién dentro del sistema.
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3. Diagrama de Arquitectura del Sistema
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Diagrama de Clases

El diagrama de clases para el videojuego educativo "Explorador del Tiempo" detalla las

diversas interacciones y relaciones entre las clases que componen la logica interna del

juego. A continuacién, se presenta una descripcion técnica de las clases principales y sus

relaciones.
Juego Jugador Nivel NPC FragmentoDocumento
i int - numero: int id: int
-id:in L i -id:

- -Stri . - descripcion: id: int o
_ T/c;rrzlioc:isst{;rngs - nombre: Str.'”g String - nombre: String - contf-:'nldo.
POUING | | - progreso: int - tiempoLimite: - rol: String usitglz;]ncsgion'
int B : :

+ iniciarJuego() +iniciarSesion() + interactuar() String

+finalizarJuego()

+guardarProgreso()

+ iniciarNivel()

J

+completarNivel()

+ darPista()

4. Diagrama de Clases

Clases Principales y Relaciones

1. Clase Juego

Atributos:

e nombre: String

e version: String

Métodos:

e iniciarJuego()

o finalizarJuego()

Relaciones:

e Asociacién con Jugador

+ recoger()
+ entregar()
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e Asociacion con Nivel

2. Clase Jugador

e Atributos:

e id:int

e nombre: String

e progreso: int

e Métodos:

 iniciarSesion()

e guardarProgreso()

o Relaciones:

e Asociacion con Juego

Asociacion con Nivel

e Asociacion con FragmentoDocumento

3. Clase Nivel

e Atributos:

e numero: int

e descripcion: String

e tiempoLimite: int

e Meétodos:

o iniciarNivel()
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o completarNivel()

o Relaciones:

e Asociacion con Juego

e Asociacion con Jugador

e Asociacion con NPC

e Asociacion con FragmentoDocumento

4. Clase NPC

e Atributos:

e id:int

e nombre: String

o rol: String

o Métodos:

e interactuar()

e darPista()

o Relaciones:

e Asociacion con Nivel

5. Clase FragmentoDocumento

e Atributos:

e id:int

e contenido: String
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e ubicacion: String

« Meétodos:

e recoger()

e entregar()

¢« Relaciones:

e Asociacién con Jugador

e Asociacion con Nivel

Diagrama de Base de Datos

El disefio de la base de datos se realiza utilizando el modelo entidad-relacion (ER), que

define las entidades, sus atributos y las relaciones entre ellas. A continuacion, se presenta

el modelo ER con las tablas, campos y relaciones.

Jugador

Nivel

idJugador: INT
nombre:VARCHAR
(100)
progreso: INT

idNivel: INT
numero: INT

VARCHAR
tiempoLimite:
INT
| idJugador: INT |

NPC

— descripcion: —

idNPC: INT
nombre:
VARCHAR(100)
rol:VARCHAR(50)
idNivel: INT

FragmentoDocumento

idFragmento:
INT
contenido: TEXT
ubicacion:
VARCHAR
idNivel: INT
_idJugador: INT |

5. Diagrama de Base de Datos

Modelo Entidad-Relacién

1. Entidad Jugador

e« Campos:
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o idJugador: INT (Clave primaria)

e nombre: VARCHAR(100)

e progreso: INT

2. Entidad Nivel

e Campos:

idNivel: INT (Clave primaria)

e numero: INT

o descripcion: VARCHAR(255)

o tiempoLimite: INT

e idJugador: INT (Clave foranea)

3. Entidad NPC

e Campos:

o idNPC: INT (Clave primaria)

nombre: VARCHAR(100)

« rol: VARCHAR(50)

o idNivel: INT (Clave foranea)

4. Entidad FragmentoDocumento

e Campos:

o idFragmento: INT (Clave primaria)

e contenido: TEXT



e Uubicacion: VARCHAR(255)

o idNivel: INT (Clave foranea)

e idJugador: INT (Clave foranea)
Relaciones

Jugador - Nivel: Un jugador puede tener multiples niveles asociados (1:N).

e Nivel - NPC: Un nivel puede tener multiples NPCs asociados (1:N).

e Nivel - FragmentoDocumento: Un nivel puede tener maltiples fragmentos de

documentos asociados (1:N).

e Jugador - FragmentoDocumento: Un jugador puede recolectar multiples

fragmentos de documentos (1:N).

1.4.2 Disefio de la Interfaz de Usuario

La interfaz de usuario (Ul) del videojuego educativo "Viajero del Tiempo" esta disefiada
para proporcionar una experiencia intuitiva y atractiva para los jugadores. A
continuacién, se describen los componentes principales de la Ul, se presentan capturas de
pantalla de las diferentes pantallas del juego y se incluye un diagrama que muestra cémo

estan organizadas estas pantallas.
Componentes de la Ul
1. Pantalla de Inicio:

o Descripcion: La pantalla de inicio presenta las opciones de juego y

configuracion.

e Opciones:
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e Jugar
e Configuracion
o Salir

2. Pantalla de Configuracion:

o Descripcién: La pantalla de configuracién permite al jugador ajustar

opciones como pantalla completa, volumen y calidad grafica.
e Opciones:
e Pantalla completa
e Volumen
o Calidad grafica
e Volver al menu inicial
3. Pantalla de Tutorial:

o Descripcion: La pantalla de tutorial introduce al jugador a las mecanicas

béasicas del juego mediante la interaccidn con un NPC.
o Elementos:
e Interaccion con NPC
o Activacion del reloj
4. Pantallas de Mision para Cada Nivel Histérico:

o Descripcion: Cada nivel histérico tiene su propia interfaz de mision,

incluyendo un cronémetro y un medidor de vidas.
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¢ Niveles:

e Nivel 1: Fundacién de Quito

e Nivel 2: Independencia de Guayaquil

« Nivel 3: Batalla de Pichincha

5. Pantalla de Tiempo Agotado:

o Descripcion: Esta pantalla aparece cuando el tiempo se agota antes de

completar un nivel.

e Opciones:

e Volver al men( inicial

Diagrama de las Diferentes Pantallas Disefiadas

El siguiente diagrama muestra como estan organizadas y conectadas las diferentes

pantallas del juego:

Pantalla de Inicio

6. Diagrama de las pantallas

, S PLORADDLT
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Pantalla de Configuracion

CALIDAD
il i 57000

ALTA \ «

\Volver

Pantalla de Tutorial
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Pantalla de Tiempo Agotado

. FIN DEL JUEGO

SE TE TERMINO EL TIEMPO, SI
QUIERES PASAR DE NIVEL TIENES QUE
ESTAR MAS ATENTO AL RELOJ

Pantallas de Mision para Cada Nivel Histérico
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Descripcion del Diagrama de Pantallas:

1. Pantalla de Inicio:

o Descripcion: La pantalla de inicio es la primera pantalla que ve el jugador

al iniciar el juego. Presenta las opciones de Jugar, Configuracién y Salir.

e Transiciones:
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o Al seleccionar "Jugar”, el jugador es dirigido a la Pantalla de

Tutorial.

o Al seleccionar "Configuracion”, el jugador es dirigido a la Pantalla

de Configuracion.

o Al seleccionar "Salir", el juego se cierra.

2. Pantalla de Configuracion:

o Descripcién: La pantalla de configuracion permite al jugador ajustar las

opciones del juego, como pantalla completa, volumen y calidad gréfica.
e Transiciones:

o Al ajustar las configuraciones, el jugador puede volver al menu

inicial seleccionando "Volver al menu inicial".

3. Pantalla de Tutorial:

o Descripcion: La pantalla de tutorial introduce al jugador a las mecanicas

basicas del juego mediante la interaccidn con un NPC.

e Transiciones:

o Despuésde completar el tutorial, el jugador es dirigido a la Pantalla

de Mision del primer nivel historico.

4. Pantallas de Misién para Cada Nivel Historico:

o Descripcién: Cada nivel historico tiene su propia interfaz de mision,

incluyendo un crondmetro y un medidor de vidas.

e Transiciones:
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o Al completar un nivel, el jugador es dirigido al siguiente nivel

historico.

« Sieltiempo se agota, el jugador es dirigido a la Pantalla de Tiempo

Agotado.

5. Pantalla de Tiempo Agotado:

o Descripcion: Esta pantalla aparece cuando el tiempo se agota antes de

completar un nivel.

e Transiciones:

o Eljugador puede volver al menu inicial seleccionando "Explorador

del Tiempo".

1.4.3 Requisitos Minimos de Hardware y Software

Requisitos de Hardware

e Procesador: CPU con al menos dos nucleos.

¢ Memoria RAM: Minimo 4 GB.

e Tarjeta Gréfica: GPU integrada compatible con DirectX 10.

e Almacenamiento: Al menos 2 GB de espacio libre en disco.

e Resolucién de Pantalla: Minimo 1280x720 pixeles.

Requisitos de Software

o Sistema Operativo: Windows 7 o superior, macOS 10.12 o superior.

e Motor de Juego: Unity 2020.3 LTS o superior.

o Bibliotecas y Dependencias:
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Unity Ul Toolkit

e TextMesh Pro

Unity Analytics
e Photon Unity Networking (PUN) (si es necesario)
1.4.4 Consideraciones Eticas y de Privacidad
Consideraciones Eticas
e Representacion Justa y Equitativa:

e Asegurar que el juego represente de manera justa y precisa a personas de

diferentes géneros, etnias y orientaciones sexuales.
« Evitar la promocidn de estereotipos negativos o discriminacion.
o Contenido Apropiado:

« Evitar la inclusion de contenido violento o inapropiado que pueda influir

negativamente en el comportamiento de los jugadores.
o Promover valores positivos como la empatia, la justicia y la colaboracion.
o Responsabilidad Social:

o Fomentar el desarrollo de habilidades cognitivas y sociales a traves del

juego.
« Incluir elementos educativos que enriquezcan la experiencia del jugador.
Consideraciones de Privacidad

e Proteccion de Datos Personales:
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o Implementar medidas de seguridad para proteger la informacion sensible

de los jugadores, como el cifrado de datos y la autenticacion segura.

e Cumplir con las regulaciones de privacidad de datos, como el GDPR.

e Transparencia:

o Informar a los jugadores sobre cémo se recopilan, utilizan y almacenan

sus datos.

« Proporcionar opciones para que los jugadores gestionen sus preferencias

de privacidad.

1.5 Conclusion del Levantamiento de Requisitos y Disefio

El levantamiento de requisitos y el disefio proporcionaron una base solida para la fase de
desarrollo del videojuego, garantizando que el sistema cumpla con los objetivos de

ensefianza de la historia ecuatoriana.
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Capitulo 11
Construccioén del Sistema

1.1 Metodologia de Desarrollo

La construccion del sistema se realizo utilizando el motor de desarrollo Unity, lo cual es
aprovechado sus capacidades de renderizado 2D para lograr un estilo en pixel art. En cada
nivel fue creado siguiendo un esquema de navegacion top-down que facilita la

exploracién por parte del usuario.

1.2 Herramientas de Desarrollo y Control de Versiones
Herramientas de Desarrollo:

1. Unity 2023.1.8f: Motor de videojuegos utilizado para el disefio, desarrollo y
renderizado en 2D.

2. C#: Lenguaje de programacion utilizado para las mecanicas del videojuego.

3. Visual Studio Code: IDE empleado para escribir y depurar el codigo.

4. GIMP/Photoshop: Creacion de sprites y elementos visuales en estilo pixel art

Herramienta de Control de Versiones:

e Git: Herramienta para el control de versiones, permitiendo registrar los
cambios realizados durante el desarrollo.

e GitHub: Plataforma en linea utilizada para gestionar el repositorio del
proyecto.

1.3 Metodologia de Trabajo
Para la construccion del videojuego educativo se utilizé la metodologia agil Scrum,
que permite organizar el desarrollo en ciclos iterativos Ilamados sprints. Este
enfoque es ideal para videojuegos, ya que facilita la constante revision y mejora de
las funcionalidades implementadas, asegurando que el producto final cumpla con

los objetivos educativos y de entretenimiento.
Scrum en el Desarrollo del Videojuego

Duracion del Sprint: 3 semanas
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Roles del Equipo:

Product Owner: Responsable de definir los objetivos principales del videojuego y

priorizar funcionalidades.

Scrum Master: Facilitador del proceso agil, encargado de eliminar bloqueos y asegurar

el cumplimiento de los sprints.

Desarrollador: Responsable de la implementacion del codigo, el disefio de mecanicas y

la optimizacion del rendimiento del juego.

Fases del Desarrollo

1. Planificacion del Sprint:
o Definicion de tareas y objetivos a desarrollar en cada sprint.
e Priorizacion de funcionalidades en el backlog del producto.
e Disefio inicial de mecanicas, niveles y elementos graficos.
2. Desarrollo:
e Implementacion de la I6gica del juego en Unity utilizando C#.

e Creacion de niveles, escenarios y sprites en pixel art.

e Programacién de mecanicas principales, como el sistema de vidas, cronometro y

enemigos.
e Integracion de efectos de sonido y musica de fondo.
3. Pruebas:
e Evaluacion de la jugabilidad y deteccion de errores.
e Correccion de bugs y optimizacion del rendimiento.
e Revision de mecanicas y ajuste de la dificultad segln pruebas de usuario.
4. Revision Final:

e Validacion del videojuego con pruebas de usuarios reales.
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e Ajustes finales en mecénicas y graficos segun el feedback recibido.
e Reuvision de la accesibilidad y facilidad de uso del juego.
5. Entrega Final:
e Documentacion del proyecto, incluyendo el manual técnico y manual de usuario.
e Generacion del instalador o empaquetado para distribucion.

e Publicacién en una plataforma de distribucion o entrega en formato digital.

Organizacion del Trabajo en Unity

El desarrollo del videojuego en Unity se organizé mediante las siguientes fases:

Levantamiento de Requisitos

e Identificacion de las funcionalidades educativas y de entretenimiento necesarias.
e Definicion de los objetivos del videojuego y su impacto en el aprendizaje.

e Creacion del backlog del producto con historias de usuario.

Disefio del Sistema

e Creacion del flujo de pantallas con el recorrido del jugador.
e Definicion de los niveles historicos, NPCs y mecanicas interactivas.

e Disefio de la interfaz de usuario (Ul/UX) con menuds, HUD y controles.

Implementacion

Desarrollo en Unity, programando las mecanicas principales en C#.

e Integracion de graficos en pixel art y animaciones.

e Creacion del sistema de colisiones, movimiento del personaje y eventos del juego.
e Optimizacion del cédigo y assets para mejorar el rendimiento en distintas

plataformas.
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Pruebas

Validacion del sistema para garantizar que cumple con los objetivos educativos y
de entretenimiento.

e Ejecucion de pruebas de estrés para evaluar el rendimiento.

e Revision de compatibilidad en diferentes dispositivos y resoluciones.

e Correccion de errores y ajustes de balance en la jugabilidad.

Publicacién y Entrega

e Generacion de una version final jugable en formato ejecutable (.exe para PC).

e Creacion de documentacion, incluyendo el manual técnico y manual de usuario.
e Publicacidn del juego en plataformas educativas o de descarga.

e Evaluacion de la recepcion del videojuego por parte de los usuarios.

1.4 Implementacién de los Requisitos en Unity

Lenguaje de Desarrollo

El desarrollo del videojuego "Explorador del Tiempo" se realizara utilizando C# como
lenguaje de programacion principal. C# es el lenguaje preferido para Unity debido a su

robustez, flexibilidad y la amplia documentacion y recursos disponibles.

Editor de Cddigo

Para la edicidn del cadigo, se recomienda utilizar Visual Studio o Visual Studio Code.
Ambos editores son compatibles con Unity y ofrecen caracteristicas avanzadas que

facilitan el desarrollo:

e Autocompletado de codigo: Sugerencias de codigo en tiempo real.

e Depuracion: Herramientas para identificar y corregir errores.
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e Integracion con Unity: Funcionalidades especificas para proyectos de Unity.

Desarrollo en Unity

El desarrollo en Unity sigue un flujo de trabajo estructurado que incluye los siguientes

pasos técnicos:
1. Configuracion del Proyecto:
« Crear un nuevo proyecto en Unity y seleccionar la plantilla 2D.

o Configurar los ajustes del proyecto en el ment Edit > Project Settings,

incluyendo la resolucion de pantalla y las opciones de compilacion.

2. Importacion de Recursos:

o Importar los recursos necesarios (sprites, sonidos, fuentes) a través del

menu Assets > Import New Asset.

e Organizar los recursos en carpetas dentro del proyecto para mantener el

orden y facilitar el acceso.
3. Creacion de Escenas:
o Crear nuevas escenas desde el menu File > New Scene.

« Configurar las escenas afiadiendo elementos de la interfaz de usuario (Ul)

utilizando el Unity Ul Toolkit.

« Utilizar el Scene View para posicionar y ajustar los elementos visuales.

4. Programacion de la Logica del Juego:
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o Escribir scripts en C# para definir el comportamiento de los objetos del
juego. Los scripts se pueden crear desde el menu Assets > Create > C#

Script.

o Utilizar componentes de Unity
como Rigidbody2D y BoxCollider2D para manejar la fisica y las

colisiones.

o Implementar la légica del juego, como el movimiento del personaje, la
deteccion de colisiones y las interacciones con el entorno. Ejemplo de un

script basico para el movimiento del personaje:

using UnityEngine;
public class PlayerMovement : MonoBehaviour
{
public float speed = 5f;
private Rigidbody?2D rb;
void Start()

{
rb = GetComponent<Rigidbody2D>();

void Update()
{
float moveX = Input.GetAxis("Horizontal™);
float moveY = Input.GetAxis(*"Vertical");
Vector2 movement = new Vector2(moveX, moveY);

rb.velocity = movement * speed,;

1. Desarrollo en Unity
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5. Pruebasy Depuracion:

Probar el juego regularmente utilizando el Game View para identificar y
corregir errores.

Utilizar las herramientas de depuracion de Visual Studio o Visual Studio
Code para solucionar problemas en el c6digo, como puntos de interrupcion
y seguimiento de variables.

6. Optimizacion:

Optimizar el rendimiento del juego ajustando la calidad grafica y
reduciendo el uso de recursos innecesarios.

Utilizar el Profiler de Unity para monitorear el rendimiento y detectar
cuellos de botella.

7. Compilacion y Distribucion:

Compilar el juego para las plataformas objetivo (Windows, macQOS, etc.)
desde el menu File > Build Settings.

Configurar las opciones de compilacion y seleccionar la plataforma
deseada.

Preparar el juego para su distribucion, incluyendo la creacion de
instaladores y la documentacion necesaria.

1.5 Desarrollo de los Niveles Histéricos

Para el desarrollo de cada nivel histérico se tomd la decision de sumergir al jugador en

una época especifica lo cual sera un nivel en especifico:

e Nivel 1: Fundacion de Quito (1534), con un escenario colonial con sus personajes

de la época y personajes historicos.

e Nivel 2: Independencia de Guayaquil (1820), en un entorno portuario y con sus

personajes historicos.

e Nivel 3: Batalla de Pichincha (1822), ambientado en una zona montafiosa también

implementando sus personajes.

1.6 Programacion de Mecénicas de Juego
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Para que el videojuego tenga una experiencia educativa, se programaron las siguientes

interfases.

e Un cronometro que desafia al jugador a completar la mision dentro de un limite
de tiempo.
e Sistema de vidas que reduce la cantidad de intentos si el jugador falla en sus
objetivos o al no completarlos.
e Interacciones con NPCs con los cuales enriquecen el contenido histérico y dan
contexto a las misiones.
1.7 Implementacion de Funcionalidades Especificas

1. Cronometro:

Se desarrollo un cronometro para agregar un desafio adicional al jugador. Este
cronometro cuenta regresivamente desde un tiempo predefinido hasta cero. Si el
tiempo llega a cero, el jugador pierde automaticamente el nivel. La funcionalidad fue
implementada usando la capacidad de Unity de actualizar constantemente el tiempo

restante en cada cuadro (frame) del juego.

2. Sistema de Vidas:

Cada jugador comienza con tres vidas al inicio del nivel. Cada vez que falla en
completar un objetivo o agota el tiempo disponible, pierde una vida. Si el jugador
pierde todas las vidas, se muestra una pantalla de derrota, y el nivel debe reiniciarse.
Esta funcionalidad fue disefiada para ofrecer un equilibrio entre dificultad y

aprendizaje.

3. Interacciones con NPCs:

Los personajes no jugables (NPCs) fueron programados para dar informacion

relevante y asignar misiones al jugador. Por ejemplo, en el primer nivel, un NPC
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proporciona pistas para encontrar un documento perdido. Las interacciones fueron
gestionadas mediante sistemas de deteccién y eventos en Unity, activandose al

acercarse el jugador

1.8 Implementacion del Backend

Dado que el videojuego no utiliza un backend ni una base de datos externa, el progreso
del jugador se gestiona localmente dentro de Unity. Para almacenar los datos, se utilizo
el sistema PlayerPrefs de Unity, que permite guardar informacion basica como el nivel

actual, las vidas restantes y configuraciones del juego (volumen y dificultad).

e Guardar Progreso:
Se implemento una funcion que almacena el nivel actual y las vidas restantes del
jugador al completar o salir de un nivel. Estos datos se guardan en el dispositivo
del jugador.

e Cargar Progreso:
Al seleccionar la opcidn “Continuar” en el menu principal, el juego recupera los
datos guardados y permite al jugador retomar el ultimo nivel completado. Esto

garantiza una experiencia continua sin necesidad de backesnd.
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Capitulo 111
Pruebas y Estabilizacion

3.1 Introduccién

Para garantizar la estabilidad y funcionalidad del videojuego educativo, se llevaron a cabo
pruebas de usuario con diferentes jugadores. Estas pruebas tenian como objetivo detectar
errores, evaluar la jugabilidad y recopilar comentarios sobre la experiencia general. Se
seleccionaron tres jugadores con distintos niveles de experiencia en videojuegos para

obtener una vision mas amplia sobre el rendimiento y posibles mejoras.

A continuacion, se detallan los resultados obtenidos durante las sesiones de prueba.

3.2 Pruebas de Jugabilidad y Errores Encontrados

Jugador 1: Andrés (Jugador ocasional, 22 afios)

Experiencia de juego:
"Me gustd bastante el estilo pixel art y la musica. La mecanica es sencilla y facil de
entender, aunque al principio no estaba muy claro qué debia hacer. Después de un rato

me acostumbré y lo disfruté.”

Errores encontrados:

o EIl personaje se queda atascado en esquinas: En algunas partes del escenario,

especialmente en los bordes de los niveles.

o El boton de pausa no responde a veces: Presioné la tecla de pausa (Escape), pero

en algunas ocasiones no funciond y tuve que presionarlo varias veces.
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o El texto de algunos dialogos sale de manera diferente: En ciertas resoluciones, los

cuadros de texto no se ajustan correctamente y algunas palabras.
Sugerencias:
o Hacer que el boton de pausa siempre responda bien.

e Ajustar la fuente del texto para que salga bien.

Jugador 2: Maria (Estudiante, 17 afios)

Experiencia de juego:
"El juego es entretenido y me gusté la temética educativa. Es facil de aprender, aunque

senti que algunas partes eran un poco repetitivas. Los graficos estan bonitos y la musica

no es molesta."”
Errores encontrados:

o Las colisiones a veces no funcionan bien: Hay momentos en los que paso por un

lado de un personaje y no me dejan pasar.

o El personaje a veces no responde a los controles: En ciertos momentos, sobre todo

después de pasar el juego, el personaje no responde al primer intento de moverse.

Sugerencias:
e Revisar las colisiones para que reaccionen de forma mas precisa.

o Mejorar la respuesta de los controles después de pasar.
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Jugador 3: Miguel (Desarrollador y jugador experimentado, 46 afios)

Experiencia de juego:
"Me gusta la idea del juego y se nota que tiene potencial. La jugabilidad es solida,
aunque hay algunos detalles que podrian mejorar. El sistema de puntuacion y vidas

funciona bien, pero algunas mecanicas pueden pulirse més."
Errores encontrados:

e Los FPS bajan en ciertos niveles: En una seccion con muchos elementos en

pantalla, el rendimiento del juego bajo y se notaron algunos tirones.

o El sonido se desincroniza si cambias la resolucion del juego: Al cambiar la

resolucion en las opciones, la masica a veces deja de sonar hasta que reinicias.
Sugerencias:
o Optimizar los niveles para que el juego corra de forma fluida sin bajones de FPS.

« Verificar que el audio se mantenga estable al cambiar la configuracion.

3.3 Conclusion y Plan de Mejora

Las pruebas realizadas permitieron identificar errores en mecanicas clave del juego, como
colisiones, pausas y reinicio de partidas. Ademas, se detectaron pequefios problemas de

rendimiento y graficos que pueden mejorarse en futuras actualizaciones.
Para corregir estos errores, se establecen las siguientes acciones:

1. Correccion de colisiones: Ajustar las detecciones de contacto entre el personajes

y el entorno.
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Mejora en la pausa: Asegurar que el juego se detenga correctamente sin afectar el

temporizador ni los controles.

Optimizacion de rendimiento: Reducir la carga gréafica en ciertos niveles para

mejorar los FPS.

Correccidn de problemas de audio: Revisar la sincronizacion de sonido al cambiar

la resolucidn o configuracion del juego.

Ajuste del sistema de reinicio: Garantizar que al regresar al menu principal se

restablezcan correctamente todas las variables del juego.
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Conclusiones

El desarrollo del videojuego "Explorador del Tiempo™ ha sido un proceso integral y
meticuloso que abarca desde la definicion de requisitos hasta la implementacion y
estabilizacion del juego. A lo largo de este proyecto, se han alcanzado varios hitos

importantes que garantizan la calidad y funcionalidad del producto final.

En primer lugar, se establecieron requisitos minimos de hardware y software ajustados
para asegurar la accesibilidad del juego en una amplia gama de dispositivos. Esto incluyd
la seleccién de una CPU de dos nucleos, 4 GB de RAM, una GPU integrada compatible
con DirectX 10 y al menos 2 GB de espacio libre en disco. Ademas, se implementaron
consideraciones éticas y de privacidad para garantizar una representacion justa y
equitativa de diferentes géneros, etnias y orientaciones sexuales, asi como la proteccion

de datos personales de los jugadores.

El desarrollo en Unity, utilizando C# como lenguaje de programacién y Visual Studio
como editor de codigo, siguid un flujo de trabajo estructurado que incluyd la
configuracién del proyecto, importacion de recursos, creacion de escenas, programacion
de la légica del juego, pruebas y optimizacién. Este enfoque iterativo permitié asegurar

la calidad y funcionalidad del juego en cada etapa del desarrollo.

Las pruebas y la estabilizacion fueron componentes criticos del proyecto. Se aplicaron
diversas metodologias de pruebas, incluyendo pruebas unitarias, de integracion, de
sistema y de aceptacion, para asegurar que todas las caracteristicas del juego funcionaran
correctamente y que el rendimiento fuera éptimo. Las estrategias de estabilizacién, como
la gestion de errores, la optimizacion del rendimiento y las pruebas de regresion, fueron

fundamentales para asegurar una experiencia de usuario satisfactoria.
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En conclusién, el proyecto "Explorador del Tiempo™ ha demostrado ser un esfuerzo
exitoso en la creacion de un videojuego educativo y entretenido. A través de un enfoque
meticuloso en el disefio, desarrollo, pruebas y estabilizacion, se ha logrado un producto
final que cumple con los objetivos planteados y ofrece una experiencia de juego de alta
calidad. La implementacién de consideraciones éticas y de privacidad asegura que el
juego no solo sea divertido, sino también seguro y respetuoso para todos los jugadores.
Este proyecto no solo ha alcanzado sus metas técnicas, sino que también ha establecido

una base sélida para futuros desarrollos en el ambito de los videojuegos educativos.
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Recomendaciones

A partir del desarrollo y la implementacion del videojuego "Explorador del Tiempo", se
han identificado varias areas de mejora y recomendaciones para futuros proyectos
similares. Estas recomendaciones estan disefiadas para optimizar el proceso de desarrollo,
mejorar la calidad del producto final y asegurar una experiencia de usuario ain mas

satisfactoria.

1. Mejora Continua del Proceso de Desarrollo

e Documentacion Detallada: Mantener una documentacion detallada y actualizada
de cada etapa del desarrollo facilita la colaboracion entre los miembros del equipo

y asegura la continuidad del proyecto en caso de cambios de personal.

2. Optimizacion del Rendimiento

e Uso Eficiente de Recursos: Continuar optimizando el uso de recursos graficos y
de procesamiento para asegurar que el juego funcione de manera eficiente en

dispositivos con especificaciones minimas.

e Pruebas de Estrés: Realizar pruebas de estrés adicionales para identificar y
corregir posibles cuellos de botella en el rendimiento del juego bajo condiciones

extremas.

3. Ampliacion de Pruebas y Feedback

o Beta Testing Abierto: Implementar un programa de beta testing abierto para
obtener feedback de una audiencia mas amplia y diversa, lo que puede ayudar a

identificar problemas que no se detectaron durante las pruebas internas.
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Analisis de Datos: Utilizar herramientas de analisis de datos para monitorear el
comportamiento de los jugadores y ajustar el juego en funcion de sus preferencias

y patrones de uso.

4. Enfoque en la Experiencia del Usuario

Accesibilidad: Implementar caracteristicas de accesibilidad, como opciones de
control personalizables y soporte para jugadores con discapacidades, para

asegurar que el juego sea inclusivo para todos los usuarios.

5. Consideraciones Eticas y de Privacidad

Revision Continua de Politicas de Privacidad: Mantenerse actualizado con las
regulaciones de privacidad de datos y ajustar las politicas del juego en

consecuencia para asegurar el cumplimiento continuo.

Educacion y Sensibilizacion: Incluir elementos educativos dentro del juego que
promuevan la sensibilizacidn sobre temas éticos y de privacidad, fomentando un

entorno de juego seguro y respetuoso.

6. Innovacion y Actualizacion

Actualizaciones Regulares: Planificar y ejecutar actualizaciones regulares del
juego para introducir nuevas caracteristicas, corregir errores y mantener el interés

de los jugadores.

Exploracion de Nuevas Tecnologias: Investigar y adoptar nuevas tecnologias y
herramientas que puedan mejorar el desarrollo y la experiencia del juego, como

la inteligencia artificial y la realidad aumentada.
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Anexos
El videojuego proporcionar dos manuales esenciales para la correcta implementacion y
uso del videojuego educativo desarrollado en Unity.
Por un lado, el Manual Técnico estd dirigido a desarrolladores y personal de
mantenimiento del software, detallando la arquitectura del videojuego, los requisitos del
sistema, la instalacion, la estructura del codigo y los procedimientos de depuracion y
actualizacién. Este manual permite garantizar la continuidad del desarrollo, facilitando
futuras mejoras o correcciones en el sistema.
Por otro lado, el Manual de Usuario esta disefiado para los docentes y estudiantes que
utilizardn el videojuego. En él se explican los pasos de instalacion, las funciones
principales del juego y las mecéanicas de interaccién, asi como soluciones a problemas
comunes que puedan surgir durante su uso.
Ambos manuales han sido estructurados con un enfoque practico y accesible, asegurando
que tanto los desarrolladores como los usuarios finales puedan comprender y aplicar la
informacion de manera efectiva. Estos documentos contribuyen a la documentacion
integral del proyecto, garantizando su operatividad y facilitando su implementacion en

entornos educativos.
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